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Features of Revit® Architecture 2015

This text presents a modern approach to using Revit Architecture. That is, it addresses advances in technology and software
evolution and introduces commands and procedures that reflect a modern, efficient use of Revit Architecture 2015. Features

include:

«— A Getting Started chapter at the beginning of the book allows users

2 Getting Started

IntrOducrion

Autodesk Revit® Architecture 2015 is the latest itera-
tion of Autodesk’s purpose-built BIM software running
on Windows-based computers. In this version, Autodesk
has refined its tab interface and improved its conceptual

arn how to sketch a
ne and add Listening
imensions

Chapter Objectives with a bulleted list of learning objectives for
each chapter provide users with a roadmap of important concepts and
practices that will be introduced in the chapter.

8. Move the cursor and click to create the endpoint of the line.

When you are sketching, you can explicitly enter a value for the length of a sketch
line by typing a dimension after you begin the sketch line. This method is known
as using Listening Dimensions.

Typically, Listening Dimensions specify linear dimensions such as length;

to get up to speed in no time to create Revit Architecture drawings.

—>

Autodesk Revit® Architecture 2015 is the latest itera-
tion of Autodesk’s purpose-built BIM software running
on Windows-based computers. In this version, Autodesk

* Learn how to sketch a
line and add Listening

Dimensions. has refined its tab interface and improved its conceptual
© Learn how to sketch a creation tools. The program can be run as either a 32-bit

rectangle. or a 64-bit version (both version options are included
* Learn how to sketch a upon install).

circle.

e tosketcha A Note from the Author

*_Learn how to sketch an arc. —

for example, the length of a line (when drawing a line), length of a chord (when <« Tips relate the aUthOr’S eXperienceS tO SpeCiﬁc Chapter Content. These

drawing the second point of a 3-point arc), or length of a radius (when drawing an

e inde, o polygan). e will enhance the student’s success in the workplace and provide real-
life tips and tricks for the problems.

9. Again, in the Architecture tab, select the Model Line button to bring up the

Notes present hints, tips, and tricks to enhance productivity.

. Delete all lines drawn in the previous
project. NOTE:

There are two Split buttons: Split

R ) Element that splits a line and Split

Select the line to bring up the Modify  yith Gap that opens a space. If you

Lines tab. use the Split with Gap button, enter

. In the Modify tab, in the Modify panel,  the gap size in the Options Bar.
select the Split button (see Figure 2-44).

4

Place an 8'-0" line in the Drawing Editor.

bed
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(SR skeTcHING A CIRcLE <— Exercises throughout the chapters provide step-by-step walk-
" opears o the 1o et of i through activities for the student, allowing immediate practice and
reinforcement of newly learned skills.

tabs to clear all selections (see
Figure 2-37).
Using the previous exercise,
drag your cursor to form a rec-
tangle around the previous exer-
cises, and left mouse click. This
will select the previous objects.
. With the objects selected, press
the <Delete> key to delete the
objects.

I

w

End-of-Chapter material, easily located by shaded bars on page edges, T Do

includes:

Visualizations in Revit Architeeture 2015, The concepts behind rendering were.

L Chapter Test Questions

e Chapter Summary
Multiple Choice

e Chapter Test Questions
e Multiple Choice

® True or False
e Questions

e Exercises

True or False

Questions

1. Where di

2. Wiy

up the Rendering dislog box?

CHAPTER

2() Tutorial Project < The Tutorial Project in Chapter 20 illustrates the methodology for

creating a set of construction documents in Revit Architecture 2015
while giving practical practice in using Revit Architecture 2015 tools.
Introduction
The purpose of this tutorial project is to illustrate the meth-

How to place a IPG logo in a



Style Conventions in Revit® Architecture 2015

Text Element Example

Tab and panel names, palette names,
menu items, and dialog box names—
Bold and follow capitalization convention
in Revit tab or pull-down menu (generally
first letter cap).

Tab names, tool buttons, and dialog box
controls/input items—Bold and follow
the name of the item or the name shown in
the Revit tooltip.

Revit prompts—Dynamic input prompts
are set in a different font to distinguish
them from the text. Command window
prompts are set to look like the text in the
command window, including capitaliza-
tion, brackets, and punctuation. Text fol-
lowing the colon of the prompts specifies
user input in bold.

Keyboard Input—Bold with special keys
in brackets.

The Section button in the View tab
The File menu

Choose the Line tool from the Draw
panel.

Choose the Symbols and Arrows button
in the Modify Dimension Style dialog
box.

Choose the Wall button in the
Architecture tab.

In the Lines and Arrows tab, set the
Arrow size: to .125.

Revit prompts you to Specify first point:

Specify center point for circle or [3P/2P/
Ttr (tan tan radius)]: 3.5

Type 3.5 <Enter>

vii
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Instructor Resources

The Online Instructor’s Manual provides answers to chapter exercises and tests and solu-
tions to end-of-chapter problems; drawing files to get users started; and lecture-supporting
PowerPoint slides.

To access supplementary materials online, instructors need to request an instructor
access code. Go to www.pearsonhighered.com/irc, where you can register for an instructor
access code. Within 48 hours after registering you will receive a confirming e-mail including
an instructor access code. Once you have received your code, go to the site and log on for full
instructions on downloading the materials you wish to use.

Student Resources

Pearson Design Central—Pearson has created an online community where students can share
examples of their drawings and obtain resources for their drawing projects. Student data files
needed for certain projects in this book can be obtained at www.pearsondesigncentral.com.
URLs in the margin direct students to the online student data files.


http://www.pearsonhighered.com/irc
http://www.pearsondesigncentral.com
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Preface

In the 14 years since it was conceived, Revit has radically changed the architectural
design and documentation industry. Not only does this purpose-built solution for Building
Information Modeling (BIM), building design, and authoring help architects and designers
capture and analyze early concepts, but it also automatically maintains the coordination of
the construction documents.

With the release of Revit Architecture 2015, users have access to a robust collection
of easy-to-use modeling tools for quick and precise design conceptualization, visualiza-
tion, and communication. This release supports several new modeling paradigms, includ-
ing intuitive direct manipulation, robust free-form modeling, and bidirectional parametric
control. In addition, some highly specialized patterning and penalization techniques are
now more readily accessible. In building design, visualizing forms in their earliest stages
enhances a designer’s ability to communicate ideas; the ability to analyze and evaluate
these forms yields an advantage in predicting and optimizing the real-world perform-
ance of the built project. These attributes form a core value of the Building Information
Modeling (BIM) process, which Autodesk® Revit® Architecture software is purpose-built
to support.

This book is based on the “hands-on tutorial” method, starting with the basic tools and
finally working up to a complete building project. As with all well-designed software solu-
tions, there is a methodology behind the operation of the interface, and that methodology is
explained through simple exercises. It is the author’s intent in these exercises to provide the
reader with a particular routine necessary to operate the program professionally.

The topics are presented and discussed in a production-based order. Once the user has
successfully completed the basic exercises, he/she can then move on to the final project,
which puts all the exercises together and illustrates the development of a real-world project
from start to finish. With the exception of the final project, this book deliberately discourages
independent design. The author, through many years of experience as an architect and profes-
sor, has found that allowing students to design while learning a software program is counter-
productive. It is therefore recommended that this book be used in the order that it has been
written. This is not to discourage design, but rather to get students “up and running” with the
basic program before they move on to more exploratory visions. Please try to become familiar
with each exercise before moving on to the next one. You must be open to different ways of
operating Revit Architecture. After completing a series of tutorials, it is often helpful to go
back and experiment with settings to see what changes happen. Although Revit Architecture
is relatively easy to understand, it is a very deep and complex program, and different opera-
tors choose to operate it in different ways.

An Instructor’s Resource website is available including PowerPoint® presentations and
an Instructor’s Manual with a proposed curriculum.

About This Book

This book can serve as a reference for architects and designers or as a guide. The text
traverses, chapter by chapter, through the complete and advanced usage of each of the
software’s capabilities. Each chapter ends with problems, with answers given in the
Instructor’s Manual. These problems can be used as test questions, additional exercises, or
homework assignments.

xiii
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Features New to This Edition

. Clearer pictures and diagrams specifically aimed at “hands-on” learners.

. Revised final building project with new features.

. Rearrangement of chapters to facilitate a more logical learning methodology.
. New 2015 Material Browser and Graphic Display Options.

. New Room and Area exercises.

. New information on point clouds.
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. New chapter on 3D printing.
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CHAPTER

The BIM and Revit Architecture

The Building Information Model
and BIM Software

R | AUTODESK® REVIT® 2015
CHAPTER OBJECTIVES

¢ Understand the history
and concept of Building
Information Modeling
(BIM).

® Understand the concept of
parametric modeling.

¢ Understand why parametric
building modeling matters.

¢ Understand the concept of . -
the one-model Building {\ AUTODESK.

Information Modeling - -— e
concept.

Image used with the permission of Autodesk, Inc. © 2014.

Introduction

Thirty-one years ago, Autodesk created AutoCAD and
revolutionized architectural drafting for the masses. With
the introduction of AutoCAD, production time decreased
significantly. Regardless, AutoCAD was only electronic
drawing—quicker perhaps, but it still followed the concept
of 2D plan, elevation, section, and detail that had been in
use for hundreds of years. Today, with Revit Architecture,
which is Building Information Modeling (BIM) authoring
software, designers are creating buildings in a new way.
Instead of depending on 2D views, they are designing
buildings virtually. This has several benefits. The first
benefit of the virtual building is its ability to allow easy
visual examination of the building from any direction. This
allows the designer to better visualize his/her design. The
next benefit is the ability to test, analyze, and quantify the
building. Because the virtual building acts like its real-
world counterpart, it is possible to analyze such things as
energy usage, shading, and component clashes. Another
benefit of the BIM is that it allows the contractors to price
and simulate the construction of the building while check-
ing different construction scenarios. This last capability
(simulation), often called 4D, has been used by many of the
large construction companies to schedule when and where
material should be delivered. Programs such as Navisworks
will combine a Microsoft® Project or Primavera schedule
with a BIM model allowing construction of a simulation
based on these scheduling programs. Finally, because the
components of the BIM model are 3D digital models, they
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are often prime candidates for automated manufacturing. It is becoming quite common for the
steel beams and stairs designed in BIM models to be sent directly to computerized steel cut-
ting and assembly machines. All of this BIM capability, though, does have drawbacks. BIM
operators are often no longer just draftspersons; they are also licensed professionals. This is
because operators of BIM software must have a much better understanding of how buildings
go together. The BIM is opening up new opportunities for those who understand how to build
and analyze models. As the BIM and Revit Architecture become an industry standard, new
operator definitions such as Virtual Constructor or Virtual Architect may be created.

Big BIM, Little Bim

Much has been written about the BIM, but few people really understand its meaning and its
impact. Finith E. Jernigan, AIA,’s book Big BIM little bim does a good job of explaining the
difference between the concept of the BIM (the Big BIM) and the software utilized to create
it (the little bim) and is highly recommended reading.

Basically, the Big BIM is defined in this book as “all the information about a project
within its property lines to the center of the earth and infinitely to the sky from its inception
through construction and use until its final decommission and elimination.” This includes the
structures and associated information, weather history, taxes, ground compaction, utilities,
manufactures, equipment, and more. Eventually the BIM will include all of the available
digital databases of information available through the Internet.

The little bim, as this author interprets Finith E. Jernigan, AIA, is the software used to cre-
ate the big BIM. To be truly viable, a BIM software solution must contain a modeler capable
of quickly and easily modeling a 3D model. If it takes longer to create the 3D model than it
would take to draw the model in three views, much of the design benefit of the BIM is lost. To
this end, the major BIM software player, Revit Architecture, includes routines that allow for
ease of modeling. Since the Building Information Model mimics a real project, some of the real
benefits on the design side can only be fully realized when the architect or designer is the com-
puter operator. This issue demands thoughtful attention from many of the large architectural
firms that have traditionally used CAD as an electronic drafting tool. They have structured
their practices with a hierarchy in which a project architect sketches a concept, and the CAD
operator merely acts as a scribe. One of the greatest values of using Revit Architecture at the
design stage is the ability for the designer to understand the relationships between the building
and its systems virtually instantaneously. This understanding may involve aesthetic, special,
performance, or program issues. Until recently, the modeling of virtual buildings has focused
primarily on improving drawing productivity in creating construction documents. One of the
great productivity features of Revit Architecture software is its ability to generate elevations
and sections automatically from the model and have them coordinated and updated whenever
a change has been made to the model. Another productivity feature is the ability to create and
maintain schedules for objects such as doors, windows, walls, and so on.

Autodesk Defines the BIM

According to Autodesk, “(BIM) refers to the creation and use of coordinated, consistent, comput-
able information about a building project in design—information used for design decision mak-
ing, production of high-quality construction documents, predicting performance, cost-estimating
and construction planning, and, eventually, for managing and operating the facility.”

Parametric Building Modeling: BIM's Foundation

What Is Parametric Modeling?

Original CAD engines used explicit, coordinate-based geometry to create graphic entities.
Editing these “dumb graphics” was cumbersome and extremely error prone. Documentation
was created by extracting coordinates from the model and generating stand-alone 2D
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drawings. As graphic engines matured, graphical entities were combined to represent a design
element (a wall, a hole, and so on). Depending on the software, the models became “smarter”
and were a bit easier to edit. Surface and solid modelers added more intelligence to the ele-
ments and enabled the creation of complex forms. However, the result was still an explicit
(coordinate-based) geometric model, which was inherently difficult to edit and had a tenuous
relationship to extracted drawings that easily fell out of sync with the model. Then parametric
modeling engines that used parameters (numbers or characteristics) to determine the behavior
of a graphical entity and define relationships between model components arrived. For exam-
ple, “the diameter of this hole is one inch” or “the center of this hole is midway between these
edges.” This meant that the design criteria or intent could be captured during the modeling
process. Editing the model became much easier and preserved the original design intent.
This was the breakthrough that gave credibility to the concept of a digital design model. The
mechanical design world (at the forefront of parametric modeling) made MCAD parametric
modeling the status quo for mechanical design. (For more information, refer to the Autodesk
Technical White Paper, Parametric Building Modeling: BIM’s Foundation, 2007.)

What about Buildings?

Unfortunately, MCAD parametric modelers do not scale to a building project. They usually
rely on two basic technologies to propagate change: history-based (which plays back the de-
sign steps for the model each time a change is made) or variational (which attempts to solve
all conditions simultaneously with each change). Using these change engines to resolve even
a small building is prohibitively slow. MCAD modelers also generally require the user to
embed a lot of constraints (such as relationships) so that the change technologies described
above can recalculate the result. These “fully constrained” models are suitable for the me-
chanical design world because the product (manufactured from raw chunks of material) has
to be precisely defined—unlike a building, which is generally a collection of prefabricated
components with relatively few constraints that really matter to a building designer. The
technology that made parametric modeling work for building design, and therefore enabled
parametric building modeling, is the context-driven change engine used in the Revit platform
for building information modeling.

Why Does Parametric Building Modeling Matter?

Why is parametric building modeling so vital to BIM? BIM is an approach to building design
that is characterized by the creation and use of coordinated, internally consistent, computable
information about a building project. Reliable building information is the essential feature of
BIM and its digital design processes. BIM solutions that use parametric building modelers
provide building information that is more coordinated, more reliable, of better quality, and
more internally consistent than object-CAD software that has been repurposed for BIM.

Purpose-Built for Architecture

Purpose-built BIM applications that use a parametric building modeler, like Revit, deliver
this kind of information by design, through the natural operation of the software. When
using a CAD solution, the graphical presentation of information (such as drawings or render-
ings) may look similar to the output of a purpose-built parametric building modeler, but is
it coordinated, internally consistent, and reliable? CAD-based technology is rarely used for
BIM, due to the extremely high level of effort required to include and coordinate actionable
building information such as schedule, cost, design scope, building performance, and so on.
More sophisticated, object CAD systems store some (nongraphical) data about a building
in a logical structure with the 3D building graphics. Users can extract this data to provide
information about quantities and attributes, just as they extract the 2D drawings from the
3D graphics. However, object CAD systems remain anchored to graphics. Because of this,
additional tools (and effort) are required to keep the graphical and nongraphical data in sync
to assure the integrity and coordination of object CAD models and to deliver the benefits of
BIM. One example of such a tool is Solibri Model Checker®, which is designed to identify
inconsistencies and errors in data produced from object CAD models before the data is used
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Figure 1-1

Government Head Quarters

Campus
(Courtesy of RTKL Architects, an
ARCADIS company)

for other purposes. The larger the project, the greater the effort required to keep the data
coordinated, and the greater the likelihood of inconsistencies. A parametric building model
combines a design model (geometry and data) with a behavioral model (change manage-
ment). The entire building model and complete set of design documents is in an integrated
database, where everything is parametric and everything is interconnected. The analogy of
a spreadsheet is often used to describe parametric building modeling. A change made any-
where in a spreadsheet is expected to update everywhere automatically. The same is true for
a parametric building modeler—real-time self-coordination of the information in every view
of the model. No one expects to have to update a spreadsheet manually. Similarly, no one
has to revise a document or schedule manually from a parametric building modeler. This
bidirectional associativity and immediate, comprehensive change propagation results in the
high-quality, consistent, reliable model output that is key to BIM, facilitating digital-based
processes for design, analysis, and documentation.

Documentation

It is Autodesk’s opinion that only a purpose-built data architecture built around a parametric
building model can provide the immediate and fully coordinated set of accurate and reliable
conventional documents. A BIM solution that can coordinate changes and maintain consist-
ency at all times lets users focus on building design versus change management. This built-in
change-management capability is critical to the disconnected building process—which is
still heavily dependent on construction documentation—providing confidence in drawing
deliverables.

The BIM and the One-Model Concept

The BIM is also about collaboration, often real-time, with other resources such as owners,
engineers, contractors, manufacturers, and so on. This collaboration should increase pro-
ductivity because more information will be available at the earlier stages of a project, rather
than later as is presently done. When informed decisions are made early in a project design,
mistakes are reduced, and costs are lowered. Part of this collaboration can also be attributed to
the one-model concept. In this concept, all of the engineers contribute their part of the model
to create a “virtual” whole. For example, the structural engineer creates the structure such as
steel frame, and it is integrated into the model being created by the architect. Some contrac-
tors have a problem with the one-model concept, preferring to create their own model specifi-
cally tailored to their needs. Other contractors prefer to work with the architect or designer
during the design process to incorporate their needs into the one-model concept. Regardless
how it is done, BIM is the direction in which building design and documentation is going.

The following figures show examples of buildings that have been designed using BIM
software (see Figures 1-1 through 1-6).
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Figure 1-2

Self Storage Facility, Pasadena Maryland
(Courtesy of HEGRA Archirects)

Figure 1-3

Government Head Quarters Facility
(Courtesy of RTKL Architects, an ARCADIS company)

Figure 1-5
Figure 1-4 -

Mission Critical Office Facility
Government Head Quarters Campus (Courtesy of RTKL Architects, an
(Courtesy of RTKL Architects, an ARCADIS company) ARCADIS company)
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Figure 1-6

Self Storage Facility, Lewes Delaware
(Courtesy of HEGRA Architects)

Additional Software and Services

Although Revit has features that speed construction documentation, new values have been
found in utilizing the information contained in the BIM model. With Revit Architecture as
the base modeling product, you can analyze, estimate, construct, and then finally manage the
operation of a project. The following are some of the additional software and services that
extend the viability of Revit Architecture.

e-SPECS® for Revit Automated Specifications

WWW.e-specs.com

Since 1998, InterSpec has provided leading specification management software as well
as specification writing services.

e-SPECS for Revit automates the preparation of construction specifications by extracting
the product and material requirements directly from the project’s model. e-SPECS solutions
integrate the entire project team into the specification development process, streamlining the
document coordination process and reducing reliance on inefficient and nonintegrated word
processing systems (see Figures 1-7 and 1-8).
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Figure 1-7

e-SPECS MasterSpec page
(e-SPECS is a product of InterSpec, Inc. Used with permission.)
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Figure 1-8

e-SPECS software
(e-SPECS is a product of InterSpec,
Inc. Used with permission.)
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IES <Virtual Environment>®

wWww.iesve.com

IES <Virtual Environment> is a unique, integrated system for building performance assess-
ment. IES <VE> consists of analysis modules that evaluate most building performance properties.

IES’s specially developed Revit plug-in toolbar allows Revit Architecture and Revit MEP
users to import their 3D BIM models into IES’s software and undertake sustainable perform-
ance analysis. It works with version 2008 onward and sits as an integrated toolbar. Drop-down
menus take you through the Setting Model Properties process step-by-step. All you need is
basic information on building type, construction materials, and heating and cooling system
types, at either the whole building or room level, depending on what stage you are at in the
design process. The Revit plug-in is included in all

IES <VE> software installations. If you already have Autodeck ‘~ Dor't rebuild - @
Revit installed on your machine, the toolbar will auto- Revit \ translate to IES
matically appear when you next open the application. C
VE-Ware and VE-Toolkits are designed exclusively /I v

for use with this plug-in to undertake early iterative r
assessments. VE-Gaia and VE-Pro allow you to

edit model properties in detail and undertake more —

== < Virtual Environment >
advance analyses. v Make Design VE-Ware
The <VE> Sustainability Toolkit makes it ex- Adjustments VE-Toolkits

tremely easy for Revit users to undertake a range < «, VE-Gaia
of building simulation analyses. Within Revit MEP, %" VE-Pro
an interface is launched enabling the user to assign 'l ,
information to the building and individual rooms. Analyse

This information is then passed through the IES Results

<VE>, and the <VE> Toolkit is displayed. Select

any button, and the Toolkit will run the chosen analysis by using the model transferred
from Revit. Interrogate the results of the analysis via an html report or conduct a more  <Virtual Environment>
detailed analysis within the <VE> using one or more of the integrated performance assess- Sustainability Toolkit
ment modules (see Figure 1-9). (Courtesy of IES VE Software)

Figure 1-9

Vico Office Suite 5D BIM Environment

www.vicosoftware.com/products/Vico-Office

Vico Office™ is purpose-built for construction. It is designed as a tightly integrated, BIM-
neutral platform to which multiple types of BIM models can be published, synthesized, and aug-
mented with cost and schedule information. To maximize efficiency and meet the distinctive needs


http://www.iesve.com
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Figure 1-10

Vico Office Suite
(Courtesy of Trimble Software)

Figure 1-11

Solibri Model Checker
(Courtesy of Solibri Inc.)

of the various construction process trades and phases, Vico Office is structured in a modular way,
providing you with a tailored, yet expandable, solution and a consistent, easy-to-use environment.

By using Vico Office, building owners and general contractors gain efficient collabora-
tion, improved predictability, risk reduction, cost management, and optimized schedules on
large, complex building projects. This software offers project teams the flexibility to special-
ize in their disciplines while they collaborate (see Figure 1-10).
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Solibri Model Checker Version 9°

www.solibri.com

Think of Solibri Model Checker as a spell-checker for virtual models. The program
analyzes building models for integrity, quality, and physical security. It checks for poten-
tial flaws and weaknesses in the design, highlights clashing components, and determines
whether the model complies with building codes and the organization’s own best practices.
You can set up rules to check just about anything in your BIM model. Figure 1-11 shows
Solibri checking fire escape routes.
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. ®
Navisworks

www.autodesk.com/products/autodesk-navisworks-family/overview

Navisworks project review software enables professionals within the fields of architec-
ture, engineering, and construction to analyze integrated models and data with stakeholders.
Its tools help teams coordinate disciplines, resolve conflicts, and plan projects early in the
process, before construction or renovation even begins.

This software is capable of importing file formats and models from most of the differ-
ent BIM software vendors. Using Navisworks, you can bring together models from different
disciplines and analyze the entire model. Navisworks comes in two versions: Autodesk
Navisworks Manage 2015 and Autodesk Navisworks Simulate 2015. If you buy the Autodesk
Building Design Suite Premium, Navisworks Simulate is included. Navisworks Manage
includes clash detection and interference checking, whereas Navisworks Simulate does not
(see Figures 1-12 and 1-13).

Figure 1-12

Navisworks clash detection
(Courtesy of Autodesk)
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Figure 1-13

Navisworks analyzes models from different disciplines
(Courtesy of Autodesk)
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Recommended Books

Aubin, Paul. Renaissance Revit: Creating Classical Architecture with Modern Software.
North Charleston, SC: CreateSpace, 2013.

Aubin, Paul. Revit Architecture 2013 and Beyond. Independence, KY: Cengage
Learning, 2012.

Eastman, Chuck, Paul Teicholz, Rafael Sacks, Kathleen Liston, et al. BIM Handbook: A
Guide to Building Information Modeling for Owners, Managers, Designers, Engineers,
and Contractors. Hoboken, NJ: John Wiley & Sons, 2008.

Jernigan, Finith E. Big BIM little bim, 2nd ed. Salisbury, MD: 4Site Press, 2008.

Vandezande, James, Eddy Krygiel, and Phil Read. Mastering Autodesk Revit Architec-
ture 2014. Hoboken, NJ: Sybex, 2013.

Websites

AECbytes
www.aecbytes.com

This is the home page for a monthly newsletter containing BIM information, software
reviews, and tips and tricks for the AEC industry.

ARCAT (Revit content)

www.arcat.com/bim/bim_objects.shtml

This is a free website containing 3D content based on manufacturers’ actual products.
AUGI (Autodesk User Group International) and AUGI Forum: Revit
www.augi.com

http://forums.augi.com/forumdisplay.php?93-Revit

AUGQI is the official Autodesk user group for all Autodesk software.
Autodesk Blogs

www.autodesk.com/blogs

Great place to get blogs by Autodesk Revit development staff.

Ed’s Independent Voice

www.hegra.org

Monthly newsletter aimed at the digital AEC industry. This newsletter discusses the
BIM, and all the new and important BIM software products.

HOK BIM Solutions (HOK’s buildingSMART community)
www.hokbimsolutions.com

HOK is one of the world’s largest architecture firms. HOK’s buildingSMART commu-
nity contains information and help on Revit and the BIM.

National BIM Standard

www.buildingsmartalliance.org

This website has information about the National Institute of Building Sciences (NIBS).
Paul Aubin Academy Master Series of Revit books

http://paulaubin.com/books

Paul F. Aubin is an accomplished author of several books on Revit Architecure,
AutoCAD MEP, and AutoCAD Architecture.

Revit Forum

www.revitforum.com

This is a free discussion forum on Revit Architecture, Structural, and MEP questions.
The Revit Kid

http://therevitkid.blogspot.com

This popular blog site contains Revit tips and tricks.


http://www.aecbytes.com
http://www.arcat.com/bim/bim_objects.shtml
http://www.augi.com
http://forums.augi.com/forumdisplay.php?93-Revit
http://www.autodesk.com/blogs
http://www.hegra.org
http://www.hokbimsolutions.com
http://www.buildingsmartalliance.org
http://paulaubin.com/books
http://www.revitforum.com
http://therevitkid.blogspot.com
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¢ TenLinks
www.tenlinks.com

This CAD electronic daily magazine includes information about the CAD industry as
well as tutorials, tips, and tricks.

* What Revit Wants

http://whatrevitwants.blogspot.com

This blog offers downloadable experimental add-ins and solutions for Revit.
* You Tube

www.youtube.com

Just search on Revit and you will find dozens of video tutorials.

Chapter Summary

This section discussed the concepts behind the BIM (Building Information Model), BIM software (BIM authoring tools), and the
benefits of the BIM.

Chapter Test Questions

True or False

Circle the correct answer.

1. True or False: The BIM is an evolution of CAD. 4. True or False: The BIM model can be used for manufac-
.. turing.
2. True or False: BIM software can be used as traditional unng
2D CAD. 5. True or False: Eventually the BIM will include all the
igital dat: f infq ti ilable th: h th
3. True or False: One of the values of the BIM is the abil- digital databases of information available through the
. . . . Internet.
ity for the designer to understand the relationships of the
building and its systems.
Questions
1. What is the difference between the BIM and BIM author- 4. How can the BIM be used for analysis?

ing software? . . . .
g 5. What is your interpretation of the Virtual Constructor or

2. How does BIM software differ from traditional 2D CAD? Virtual Architect?

3. What does “4D” mean in relationship to BIM software?
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CHAPTER OBJECTIVES

Learn how to sketch a
line and add Listening
Dimensions.

Learn how to sketch a
rectangle.

Learn how to sketch a
circle.

Learn how to sketch a
polygon.
Learn how to sketch an arc.

Learn how to sketch a
spline.

Learn how to split a line
(works for lines, circles,
arcs, or walls).

Understand families.
Understand levels.
Understand check boxes.
Understand radio buttons.

Use and understand
contextual menus.

Use and understand
constraints.

Understand dialog boxes
(menus).

Understand object snaps.

Getting Started

Introduction

Autodesk Revit® Architecture 2015 is the latest iteration
of Autodesk’s purpose-built BIM software running on
Windows-based computers. In this version, Autodesk
has refined its tab interface and improved its conceptual
creation tools. The program can be run as either a 32-bit
or a 64-bit version (both version options are included
upon install).

A Note from the Author

* There is a philosophy behind the “hands-on” tutorial
method used in this text. I have designed these tuto-
rials to give the student an experience of the opera-
tion methodology that I feel is effective for learning
to operate Revit Architecture, and especially for those
who are kinesthetic learners such as I.

« After you have completed a series of tutorials, it is
helpful to go back and experiment with settings to see
what changes happen.

In my opinion, the operation of any architectural design
and documentation software can be analogized both to
driving an automobile with a manual transmission and to
playing a game of chess. I often remind my new students
how difficult it seemed when they first tried to drive an
automobile, especially one with a manual transmission.
Then I ask them to remember any of the actions they made
while driving to class. If they have a car with a manual
transmission, do they remember changing gears? The
point is this: when one practices using the tools on simple
tasks, those tasks (like using a clutch in an automobile)
become routine.

Operating Revit Architecture effectively depends on
picking the correct tool for a particular task. Chess is a
game of strategy, and operating Revit Architecture effi-
ciently is similar to playing chess.

The goal in Revit Architecture is to get the most result
with the least effort (keystrokes) and picks. In order to do
this, you must be thinking several moves ahead with a clear
goal in mind. As with chess, your building project will
always be opposing you (as all projects do). Don’t be afraid
of trying a new strategy (unless you are on deadline), and
practice, practice, practice.

13
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Figure 2-1

The Revit Architecture
Recent Files screen

Finally, you must be open to learning different ways to operate Revit Architecture.
Although Revit Architecture is relatively easy to understand initially, it is a very deep
and complex program, and different operators choose to operate it in different ways.

Let’s get started!

Creating a Project

Following is the process for creating a new project in Revit Architecture.

1. Whenever you start Revit Architecture 2015, the Recent Files screen appears.

2. Select the Architectural Template button (under Projects) to bring up the Autodesk

Revit Architecture Workspace (see Figure 2-1).

-

Projects

= (e

T

Projects

=

3. The Revit Architecture interface will appear, and you will
be ready to work (see Figure 2-2).

4. Once inside a Revit project, more projects can be created or
opened by pressing the R (Revit logo) at the top left corner
of the interface to bring up the Application menu.

5. In the Application menu, select > New > Project to bring
up the New Project dialog box.

In the New Project dialog box, select the Project radio button.

NOTE:

You can open existing
projects from either the
Recent Files screen or
the Application menu
by selecting the Open
button.

Select Architectural Template from the Template file drop-down list.

8. In the New Project dialog box, select the OK button to create a new project (see

Figure 2-3).
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Figure 2-2

The Revit Architecture interface

Application Menu Figure 2-3

Application menu
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Figure 2-4

Options menus

Figure 2-5
Architecture tab

9. In the Application Menu dialog box, select the Options button to bring up the general
Options menus (see Figure 2-4).
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Tab Menu Interface

The Microsoft-inspired menu interface was new to Revit 2010; it has been refined each year
culminating with Revit 2015. The tab displays automatically when you create or open a file. It
provides all the tools necessary to create a project and automatically changes when you select
an object. The Tab interface has the hierarchy of Tab > Toolbar > Panel > Button. Each tab
contains its toolbar. Buttons activate specific operations you wish to perform, and they are
located in panels that are located on a toolbar. The toolbar can be customized by rearranging
the panels that contain the buttons desired.

The Revit 2015 Tab menu contains twelve tabs: Architecture, Structure, Systems, Insert,
Annotate, Analyze, Massing & Site, Collaborate, View, Manage, Add-Ins, and Modify.

Architecture Tab

The Architecture tab contains panels and buttons for creating the building model. Among
these are buttons for creating walls, doors, windows, components (objects such as furniture),
roofs, stairs, rooms, and area objects. Also included in this tab are Grid and Work Plane
buttons for placing objects (see Figure 2-5).
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Structure Tab

The Structure tab contains panels and buttons used for creating, placing, and modifying
structural elements and foundations (see Figure 2-6).

/ Figure 2-6

Structure tab
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Systems Tab

The Systems tab contains panels and buttons for (MEP) HVAC, Plumbing, and Electrical
objects. By selecting the arrows in the lower right of each panel, more screens are provided
to automate and dictate parameters for the MEP systems (see Figure 2-7).

Figure 2-7
Systems tab
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Insert Tab
The Insert tab contains panels and buttons for electronically linking and managing files,
inserting point clouds from 3D scanners, inserting decals (2D jpgs) on surfaces, and import-
ing images and CAD files. Besides this, it contains the important button to load families and
groups (see Figure 2-8).
Figure 2-8
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18 Part One Getting Started

Annotate Tab

The Annotate tab contains panels and buttons for adding 2D annotations to your drawings.
Adding dimensions, text, tags, and other View-specific objects means that they are used only
in plan, elevation, or drafting views (see Figure 2-9).

Figure 2-9
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Analyze Tab

The Analyze tab contains panels and buttons used for setting and analyzing Energy Models
(see Figure 2-10).

Figure 2-10
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Massing & Site Tab
The Massing & Site tab contains panels and buttons for modeling and modifying conceptual
mass families and site elements (see Figure 2-11).
Figure 2-11 /
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Collaborate Tab

The Collaborate tab contains panels and buttons for collaboration with internal and external
project team members (see Figure 2-12).
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View Tab

The View tab contains panels and buttons used for managing and modifying the current view
and for switching views (see Figure 2-13).
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Manage Tab

The Manage tab contains panels and buttons for managing project and system parameters
and settings. Here one can locate the Material Browser, set the object snap, enter location
address, and enter owner information. Additionally, both Phasing and Design Options pan-
els are located here (see Figure 2-14).
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@
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Additional | L Design
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Add-Ins Tab
The Add-Ins tab allows access to external and third-party tools (see Figure 2-15).

Figure 2-12
Collaborate tab

Figure 2-13
View tab

Figure 2-14
Manage tab
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Figure 2-15
Add-Ins tab

Figure 2-16
Modify tab

Figure 2-17

View Control Bar changes
depending on view
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Modify Tab

The Modify tab contains panels and buttons used for editing existing elements, data, and
systems. When working with the Modify tab, select the button first; then select the objects
you want to modify (see Figure 2-16).
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View Control Bar

The View Control Bar changes slightly depending on the view. It contains controls for the fol-
lowing buttons: View Scale, Detail Level, Graphics Style, Sun Path, Shadows, Crop Region,
Lock View, Render dialog menu, Temporary Hide/Reveal Hidden Elements, Temporary
View Properties, and Highlight Displacement Sets (see Figures 2-17 through 2-25).
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Figure 2-18 Figure 2-19
View Scale drop-down list The Detail Level button

Detail Level
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Figure 2-20
The Visual Style button
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Figure 2-21

The Graphic Display Options button

Figure 2-22

The Sun Path & Sun
Settings button
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Shadows On/Off

ygr=1or FEH% 0 GREEREY (B a

Figure 2-23
The Shadows On/Off toggle

Reset Temporary
{ a0 4

- Show and Hide
Crop Region
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Figure 2-24
Show/Hide Crop Region toggle

Figure 2-25

Temporary Hide and Reset options

User Interface Button

The User Interface drop-down list is activated by selecting the User Interface button,
always located at the top right end of the tab in all views. If the Properties Panel or Project
Browser disappears, this is the place to go to bring it back (see Figure 2-26).
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Navigation Wheels

1. When in a view, the Navigation Bar will appear if one has checked the
Navigation Bar check box in the User Interface drop-down list.

2. When in a 2D view, click on the Magnifier icon in the Navigation Bar Figure 2-27
to bring up the 2D Wheel. When in a 3D view, click on the Magnifier
icon in the Navigation Bar to bring up the Full Navigation Wheel (see
Figure 2-27).

3. Drag your Wheel to the center of your drawing by moving your cursor (the Wheel will follow
your cursor); then click, hold, and move your cursor over the word ZOOM. The workspace
will then zoom in toward the center of the Wheel. Repeat for the word PAN to move the view.

2D and 3D Navigation Wheels

4. The Rewind option in the Wheel allows one to re-track to any previous view (see
Figure 2-28).

i JE— [ : — — ——— Figure 2-28
AL E IS e
] | — | L Y
)

5. If you are in a 3D view, clicking on the Magnifier icon
will bring up the Full Navigation Wheel. Experiment with
ZOOM, CENTER, ORBIT, and other options, as you did ~If you hold down the
with the 2D Wheel. If you click and drag the CENTER but-  <>hift>+w keys, the
ton to a spot on your model, and then click on the ORBIT NawgationlWheel il
button, the view will rotate about that center point. S

NOTE:
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6. In either wheel, click on the lower right drop-down list to show the Wheel options. Ex-
periment with the different settings (see Figure 2-29).
Figure 2-29

The Navigation Wheel
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ViewCube

The ViewCube appears only when you are in a 3D or Camera view. Clicking on the cube
places you in a Top, Front, Right, Left, Back, or Bottom view. Clicking on the House icon
adjacent to the cube returns you to the 3D view. Moving the compass “orbits” the view in
real time. You can turn the ViewCube on or off when you check the ViewCube check box
in the User Interface drop-down list (see Figure 2-30).

Figure 2-30 % =7

Select the House icon to
return to the standard
3D view
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You can modify the ViewCube properties by selecting Options from the Application
menu and selecting the ViewCube tab (see Figure 2-31).
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Sketching and Edit Mode

In earlier releases of Revit Architecture, the term Sketch mode was used to refer to the draw-
ing of lines, circles, and so on. The completion of a 2D sketch that resulted in a change in a
3D object was termed as Finish Sketch mode. Since Revit 2012, the term Edit mode is used
more often. Now, when a 3D object is changed by a 2D sketch, the object is said to be in Edit
mode, and its completion is referred to as Finish Edit mode. Regardless, the terms refer to
the same process. Because older users often refer to drawing as “sketching,” these two terms
can be used interchangeably.

There are several terms specific to the sketching or editing process in Revit Architecture:

+ Sketching and Edit mode is a process of drawing 2D elements in Revit Architecture.

+ Sketching and Edit mode is similar to 2D drawing in AutoCAD, and much of the 2D
detailing is done with Sketch buttons such as Line, Circle, Arc, Rectangle, and so on.

+ Sketch-based elements are those that are typically created using Edit mode (for exam-
ple, floors, ceilings, and extrusions). Other elements, such as walls, are sketched but do
not require the use of Sketch mode.

+ Sketch and Edit mode is the environment in Revit Architecture that allows you to sketch
elements whose size or shape cannot be determined automatically; for example, when
you create or edit a sketch of a roof or a floor. When you enter Edit mode, the tab dis-
plays only the buttons applicable for the type of sketch you are creating or editing.

+ All of the elements that comprise a sketch-based element (such as a roof) are known as
the sketch.

SKETCHING A LINE AND ADDING LISTENING DIMENSIONS

1. Start a new drawing using the Architectural template.

2. In the Project Browser, double-click on the LEVEL 1 floor plan to bring it into
the Drawing Editor.

Figure 2-31

The ViewCube dialog box
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3. Change the Drawing Scale to 1/4" =1'-0".
4. Select the Architecture tab.

5. In the Draw panel, select the Model Line button to bring up the Modify | Place
Lines tab.

6. In the Modify | Place Lines tab, in the Draw panel, select the Line button and
select Wide Lines from the Lines drop-down list (see Figure 2-32).

Figure 2-32
The Line button and

Muodify | Place Lines

f 2 «1 e =
Lines drop-down list ' " & E}f © IR Line Style:
] = e e l'(ﬂh f %’ ¥ || Lines -
5|x ,\f@. GJD;lﬁ = |
| View Measure Create i Draw Line Style I

[T Radius: |1' " /

7. Click in the Drawing Editor to specify the start point of the line.
8. Move the cursor and click to create the endpoint of the line.

When you are sketching, you can explicitly enter a value for the length of a sketch
line by typing a dimension after you begin the sketch line. This method is known
as using Listening Dimensions.

Typically, Listening Dimensions specify linear dimensions such as length;
for example, the length of a line (when drawing a line), length of a chord (when
drawing the second point of a 3-point arc), or length of a radius (when drawing an
arc, circle, or polygon), etc.

9. Again, in the Architecture tab, select the Model Line button to bring up the
Modify | Place Lines tab.

10. In the Draw panel, select the Line button to bring up the Modify | Place Lines
tab.

11. In the Modify | Place Lines tab, in the Lines drop-down list, select Wide Lines.

12. In the Options Bar, check the Chain check box (this will allow you to start new
lines connected to previous lines (see Figure 2-33).
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13. Click in the Drawing Editor to specify the start point of the line.

14. Type the length value. When you type a number, a text box appears. If you need a
line that is 8 feet 6 inches long, type the value as 8 6, and press the <Enter> key.
The sketch line is drawn the specified length.

15. Press the <Esc> key to finish the command, or move your cursor to a new direc-
tion and repeat with another value (see Figure 2-34).
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Figure 2-34

Listening Dimensions

Listening Dimension

l

9 (11{e =528 SKETCHING A RECTANGLE

1. Using the previous project, select the Architecture tab.

2. In the Draw panel, select the Model Line button to bring up the Modify | Place
Lines tab.

3. In the Draw panel, select the Rectangle button.

4. On the Options Bar, check the Radius check box, and enter 1'-0" in the Radius field.

5. Click to place the rectangle, then drag its corner, and click to place a rectangle with
radius corners.

6. Adjust the rectangle either by selecting an edge and dragging it or by entering a
new dimension in Listening Dimensions (see Figures 2-35 and 2-36).
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Figure 2-36

Drag to the upper right, and click to form the rectangle with round corners

NOTE:
Don't check the Radius check box if you want square corners.
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Figure 2-38

The Radius for the circle is
located in the Options Bar

2 4@ P2 SKETCHING A CIRCLE

1. Select the Modify button that m = H S s
appears to the top left of all | .ch @ = = -
Architecture | Structure  Systems

tabs to clear all selections (see ;

Figure 2-37). h Q @
2. Using the previous exercise, —

drag your cursor to form a rec- Modify "."'.n'vall Door ‘Window Comp'nnent
tangle around the previous exer- . _
cises, and left mouse click. This | Select - ! Modify
will select the previous objects. |

3. With the objects selected, press ——
the <Delete> key to delete the = |
objects. I

4. If you are not sure whether there
are objects still out of view,
press ZA (Zoom All) to extend  The Modify button is always located at the

the view to all objects. top left of the interface
5. Select the Architecture tab.

6. In the Draw panel, select the
Model Line button to bring up the Modify | Place Lines tab.

7. In the Draw panel, select the Circle button.

Figure 2-37

8. Click in the Drawing Editor to set a center point.

9. Optionally, preselect Radius in the Options Bar and specify a value. If you
specify a radius, placing a circle in the drawing area requires only one click.

10. If you have not already specified a radius, just move the cursor, and click to complete
the circle, or type in a dimension in the Listening Dimension (see Figure 2-38).
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24{e 1] P20 2 SKETCHING A POLYGON

1. Delete any objects from the previous exercise.
2. Select the Architecture tab.

3. In the Draw panel, select the Model Line button to bring up the Modify | Place
Lines tab.

4. In the Draw panel, select the Polygon button.

5. Preselect Radius and Sides in the Options Bar and specify a value. If you specify
a radius, placing a polygon in the drawing area requires only one click.

6. Click in the Drawing Editor to set a center point (see Figure 2-39).
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231 PR3 SKETCHING AN ARC

1. Delete any objects from the previous exercise.
2. Select the Architecture tab.

. In the Draw panel, select the Model Line button to bring up the Modify | Place
Lines tab.

. In the Draw panel, select the Start-End-Radius Arc.
. Click in the Drawing Editor to set a point.

W

. Drag to the right and click to set a width.
. Move your cursor upward or downward and click to set an Are.

0 N N L b

. Notice that the center of the arc is automatically located (see Figure 2-40).
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Figure 2-40
The Start-End-Radius Arc button in the Draw panel

SKETCHING A SPLINE

1. Delete any objects from the previous exercise.
2. Select the Architecture tab.

3. In the Draw panel, select the Model Line button to bring up the Modify | Place
Lines tab.

4. In the Draw panel, select the Spline tool (see Figure 2-41).
 Colsborate Ve Masge ASSIS: VMody | PleceLies |G

| oim ‘D;I‘ . E . /.U@ 4
} '_-| . = = ‘,“"fjpl _ ILLlneSt

i | . | o | 0—E Lines
| =3 spline ¥
Creates a smooth curve that passes through or near specified points. | |

29

Figure 2-39

The Radius and Sides for
the polygon are located in the
Options Bar

Figure 2-41

The Spline button in the
Draw panel
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Figure 2-42

The Add Control button in
the Edit Spline panel

Figure 2-43

Moving Control Points
changes the curve

Figure 2-44
The Modify > Split button

5. Click in the Drawing Editor to set a point.

6. Place four random points and notice that a free-form line appears. After placing

the last point, press the <Esc> key to end the command and create the spline.

7. Select the spline to bring up the Modify | Place Lines tab.
8. Select one of the straight lines between Control Points.
9. In the Edit Spline panel, select the Add Control button to add a Control Point

(see Figure 2-42).

_

It_, ‘"\:: oW @?—" iiﬁg|

] « | Convert (4 Add Delete | Edit Pidk
Lines / Control Control | Work Plane New
Style Edit Edit Spline Wark Plane
10. Drag the new Control Point to adjust the curve.
11. Repeat, adding or deleting Control Points and dragging to change the curve (see

Figure 2-43).

2 {3{e P52 SPLITTING A LINE (WORKS FOR LINES, CIRCLES, ARCS, OR WALLS)
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1.

2. Place an 8'-0" line in the Drawing Editor.

Delete all lines drawn in the previous
project. NOTE:
There are two Split buttons: Split

Element that splits a line and Split

- Select the line to bring up the Modify  yith Gap that opens a space. If you

Lines tab. use the Split with Gap button, enter

. In the Modify tab, in the Modify panel,  the gap size in the Options Bar.

select the Split button (see Figure 2-44).

Modify
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5. Click at two places on the line and delete the midsection of the line (see
Figure 2-45).

Click Click

NOTE:

If you select the Split

button, you click in
A only one spot on the

line to split the line
into two pieces with
no gap.

Delete

E—— S ——
Figure 2-45

Click in two places and delete the midsection

Try splitting other sketch lines (see Figure 2-46).

Figure 2-46
Splitting lines

P

You can get more information on Sketching, Editing, and Edit modes in the Revit
Help file. ‘

Families

All objects in Revit Building are “Family based.” The term Family describes a concept used
throughout Revit Building to help you manage your data and make changes easily. Each
Family element can have multiple types defined within it, each with a different size, shape,
material set, or other parameter variables as designed by the Family creator. Changes to a
Family-type definition propagate through a project and are automatically reflected in every
instance of that Family type within the project. This keeps objects coordinated and saves you
the time and effort of keeping components and schedules up-to-date manually.

To load a family, select the Insert tab.

2. In the Insert tab, in the Load from Library panel, select the Load Family button to
bring up the Load Family dialog box.

3. Inthe Load Family dialog box, double-click on the desired Family category to open all
the families in that category (i.e., Doors, Windows, etc.).

4. You can also see all the preloaded families by selecting the category in the lower area of
the Project Browser (sece Figure 2-47).
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Figure 2-47
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Levels

Levels are horizontal planes that act as a reference for elements, such as roofs, floors, ceilings,
and so on. These levels, which are seen only in the elevations, correspond to levels in the
Project Browser. Adding new levels in any Elevation View will add corresponding levels in
the Project Browser (see Figure 2-48).

___Roof
22'-51/4"

Figure 2-48

Level planes can be
viewed only in elevations
and sections

TOP REAR ROOF
17'-3 14"

Level 2
10'-31/4"

Level 1 &
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Elements

All objects in Revit Building are referred to as Elements. These include, but are not limited
to, Lines, Circles, Components, Walls, Window, Doors, Roofs, Stairs, and so on.

Check Boxes

Check boxes indicate the On or Off state of available options. If they are in a group, several
check boxes can be selected at the same time (see Figure 2-49).

Inztance Parameters - Control selected or to-be-created instance

| Parameter | Walue | 2
EoabaEbIne. o e l""""a” Centerline |
Base CONSLAANE o EBYELL
Base Offset N L i S '

Baseis Attached 7]
Base Extension Distance i
‘Unconnected

Top Constraint
Unconnected Height oam
Top Offsst W

TopisAttached
Top Extension Distance o' 0"
RoomBounding

StructuralUsage  Monbeatng oo

’_ oK ] [ Cancel

Figure 2-49
Check box

Radio Buttons

Radio buttons (the name comes from the button selectors on car radios) indicate the On
or Off state of available options. Only one button in a group of buttons can be chosen (see
Figure 2-50).

Liagoanal aown \\\\\\\\\\\\\\\\\

BLHBIHBHIHBH
S

Diagonal doven-small

Diagonal up

() Dirafting () Model

[ OE. J ’ Cancel

Figure 2-50
Radio button
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Contextual Menus

. In Revit Architecture, right mouse button (RMB) clicking on an object will bring up a

menu that contains commands available for that object.

Contextual (context-sensitive) menus became popular when Microsoft introduced
Windows 95.

Revit Building uses these menus to control options and subcommands of various com-
ponents.

Contextual menus typically are summoned by clicking the right mouse button on a
specific object, entity, or spot in the interface. Through programming, the appro-
priate menu or “context” will appear for that object at that point in its command
structure.

As an example, clicking the right mouse button on a door within a wall will provide all
the commands available for the door and its relationship to the wall. Right mouse click-
ing in an empty area of the Drawing Editor (drawing area) will also bring up a contex-
tual menu with controls for that view (see Figure 2-51).

Cancel

Repeat [Door]
Recent Commands 3

Ratate

Flip Hand

Flip Facing

FElip Wiork Flame

Hide in View 4
Override Graphics in View #

Create Similar

Edit Family

Select Previous

Select All Instances 3
Delete

Find Referring Views

Zoom In Region
Zoom Out (2x)
Zoom To Fit

Previous Pan/Zoom
Nk Fan /2o
Browsers

Figure 2-51

Contextual menu for a door
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Constraints (Pins)

Constraints (or Pins) are located in all Modify panels. Pins are very helpful when you wish
to hold an entity such as a wall in place while changing the dimension of an adjacent wall, or
just lock a series of elements so that they cannot be changed. Once an entity is pinned (locked
in place), it can be unpinned again by going to any Moedify panel and selecting the Unpin
button (see Figure 2-52).

Madify | Wals Figure 2-52
[ | s oin a — N —- )
E] = Pl le o8 & @ - | —— [Eb] [(EJJ @ Constraints (Pins)
+ G =% B8 .= .
S haa =&
Modify View Measure Create Mode
@

Dialog Boxes (Menus)

1. In Revit Architecture, clicking on an object will bring up dialog boxes (or menus) that
contain commands available for that object.

2. Dialog boxes (or menus) contain properties, drop-down lists, selection buttons, text and
comment locations, etc. (see Figure 2-53).

T [TITT N X
- nad
| p— ! raniy: [T -] |
Generic - 8°
Type: |Genenc -5 =l Dupicate,.. |
walls (1) =] H Edit Type Rename. . |
Constramts .3 =
Location Line [Wall Centerine 1 e
Base Constraint Level 1 | Parameter | Vake [
Base Offset o 0"
s ] |5wunue Edkt !
Sp i s d Wrapping at Inserts Do not wrap
Unconnected Height x 0
[ ]
Room Bounding ¥
Structural &
Structural L
Enabie Analytical Mode ]
Dmersions 2
Identity Data &
Image
Comments Assembly Descript Exterior Wals
Mark |Assambly Code 52010
2 Type Mark
Phase Created New Construction Fire Ratng
Phase Demalshed Naore Cost
Propertics holp Apply I Heal Transfe
Absorptance 0. 700000
Rouchness 3 d
<< Preview oK I Cancd | gl I
&
Figure 2-53

The Revit dialog box
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Object Snaps

Object snaps allow you to grab onto objects and lines at predetermined locations, automati-
cally, when doing operations such as Move, Copy, Rotate, and so on. This concept comes
to Revit Architecture from the 2D CAD programs. The Snaps dialog box can be reached by
clicking on the Snaps button in the Manage tab. With the Snaps On, Revit Architecture
displays snap points and snap lines to assist in lining up elements, components, or lines with
existing geometry. Snap points depend on the type of snap and are represented in the drawing
area as shapes (triangles, squares, diamonds, and so on). Snap lines are represented as dashed
green lines in the drawing area.

In the Snaps dialog box, you can check which snaps you wish to appear automatically
when you make an operation. You can enable or disable object snaps and specify dimension
snap increments. You can also override snap settings using keyboard shortcuts (see keyboard
shortcuts in the Help file). Settings are held for the duration of the Revit Architecture ses-
sion. Snap settings apply to all files open in the session but are not saved with a project (see
Figure 2-54).

GHG-R-@-2-FO0A G-0E S&R-5 ]
Manage
mp % 01 FE M
TEEEEL R IEEEE
Modify| Materials Object |Snaps| Project Project Project Shared Transfer Purge Structural  MEP Panel Schedule  Adc
Styles | Information Parameters Units Parameters Project Standards Unused Settings Setmgs. Templates =~ Se
Snaps Settings
Specifies snap increments, enables or disables snap points.
Press F1 for more help
Snaps .51
/ ™ Snaps Off 50)
- Dimension Snaps
Snaps adjust as views are roomed.
The largest value that represents less than 2mm on screen is used.
[¥ Length dimension snap ts
|4:06;0 1";0 0ys";
¥ anguiar dimension snap increments
| 90.000° ; 45.000° ; 15.000° ; 5.000° ; 1.000°;
~ Object Snaps - = - — - == = =
¥ Endpoints (5E) ¥ intersections ()]
¥ Midponts {sM) ¥ Centers {s0)
¥ Nearest (5N) ¥ Perpendicular (sP)
¥ Work Plane Grid (sw) ¥ Tangents (sm)
¥ Quadrants (5Q) ¥ Points %)
checkAl | checknone |
¥ Snap to Remote Objects (sR) ™ Snap to Point Clouds [ao]
~Temporary Overrides —— - - - - Ml
While using an interactive tool, keyt d shortcuts (sh in parentt ) can be
used to specify a snap type for a single pick.
Object snaps Use shortcuts ksted above
Close [ral
Turn Override Off (s5)
Cyde through snaps (TAB)
Force horizontal and vertical (SHIFT)
[k | coe |  weo |
Figure 2-54

The Snaps dialog box
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Abbreviations

In order to make this text easier to understand, shortcut abbreviations are often used. The

following list codifies those abbreviations.

Please Read Before Proceeding

Revit or Revit
Architecture

Refers to Autodesk Revit Architecture 2015.

Browse

Refers to searching through the file folders and files.

Contextual menu

Refers to any menu that appears when an object or entity is selected with a
right mouse button (RMB).

Cut Plane

Height at which a plan view is displayed; usually 3'-4'.

Dialog box

Refers to any menu containing parameters or input fields.

Display tree

Refers to Microsoft Windows folder listing consisting of + and - signs. If a +
sign appears, then the listing is compressed with more folders available.

Drawing Editor

Refers to the drawing area where drawings and 3D models are created.

Drop-down list

Refers to the typical Windows operating system list. When selected, a series
of options appears in a vertical list.

DWG

Refers to an AutoCAD drawing.

Elevation View

Refers to Front, Back, Right, or Left View, perpendicular to the ground
plane.

<Esc> key

Refers to the <Esc> key on the keyboard.

Floor Plan View

Refers to looking at a plan from the Top View.

Model, Virtual model

Refers to a 3D representation of a real building or component.

Press the Enter button

Refers to any Enter button in any dialog box on the screen.

Press the <Enter> key

Refers to the <Enter> key on the keyboard.

Press the OK button

Refers to any OK button in any dialog box on the screen.

Project Browser

Refers to the list of views contained in the project.

Properties dialog box

Dialog box that appears when an object is selected. This dialog box con-
tains changeable parametric data about the selected object.

Reference Plane

Custom plane upon which objects are placed.

RMB Refers to clicking using the right mouse button. This is most often used to
bring up contextual menus.

Rfa file Refers to a Revit Family file.

Rvt file Refers to a Revit project file.

Section View

Refers to a longitudinal or transverse cut through the model.

Tooltips

Refers to the information that appears when the cursor is held momentarily
over an icon.
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CHAPTER OBJECTIVES

Learn how to change the
settings for Listening
Dimensions.

Learn ways to place a Wall
object.

Use Pick Lines on an
imported 2D CAD file.

Learn how to create and
modify Wall objects.

Create Wall Sweeps and
Reveals.

Create and modify Curtain
Walls.

Learn how to use Join
Geometry and Wall Joins.

Modify vertically
compound walls.

Create a profile for a Wall
Sweep.

Create a compound
wall with the SWEEP
command.

Modify End Caps and
Insert conditions.

Create embedded walls.

Walls

J2HG - G- 2 S OA G- FE -~
Architecture | 9 = Systems  Insert  Annotate lyze  Massing &Site

Modify Wall | Door Window Component — Column Roof Ceiing Floor Curtain C
b ™ ™ T System

Build
Wall: Architectural

Wall: Structural

uoo

Wall by Face

Introduction

Wall objects are the basis of all buildings. They enclose
space and give the building its character. Because build-
ings require a vast variety of wall types and configurations,
these objects have become very sophisticated in Revit
Building. Walls can function as interior, exterior, founda-
tion, and retaining. All walls have a structure that can be
defined through the type properties of the wall. In addition,
various instance and type properties can be specified to
define the appearance of the wall.

Creating a Wall

You create a wall by sketching the location line of the wall
in a Plan view or a 3D view. Revit Architecture applies the
thickness, height, and other properties of the wall around
the location line of the wall. The location line is a plane in
the wall that does not change, even if the wall type changes.
For example, if you draw a wall and specify its location line
as Core Centerline, the location line remains there, even if
you select that wall and change it to another type or change
its structure.
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40 Part One Getting Started

2@ 35 B CHANGING THE SETTINGS FOR LISTENING DIMENSIONS

1. Select the Manage tab.

2. In the Manage tab, in the Settings panel, select the Additional Settings button to
open its drop-down list.

3. In the Additional Settings drop-down list, select the Temporary Dimensions
button to bring up the Temporary Dimension Properties dialog box

4. Select the Walls Faces and Doors and Windows Centerlines (see Figure 3-1).

Figure 3-1 iBleBa S

EEL

S-L OA 8-

The Temporary Dimension T
Uf; [x8

Properties dialog box ks = ]
[Modify| = Materials Object Snaps  Project Project Project Shared Transfer Purge Structural MEP Panel Schedule | Additional |
| Styles Information Parameters Units Parameters Project Standards Unused Settings  Settings Templates Settings
e = = e
F.I Patterns

_—
(D) | Materal assets
@ Analysis Display Styles

F  Sheet IssuesRevisions
-

rronhends
1) Temporary Dimensions
o

S cetseve

[llfﬁ} Assembly Code

9 {F{e 32 PLACING A WALL OBJECT

1. Start a new drawing using the Architectural template.

. In the Project Browser, double-click Floor Plans > Level 1 to bring Level 1 up
into the Drawing Editor.

. Set the Detail to Medium (see Figure 3-2) so that you can see the wall compo-
nents in Level 1 Plan view).

. In the Architecture tab, in the Build panel, select the Wall > Architectural Wall
button to bring up the Modify | Place Wall tab.

. In the Properties dialog box, click in the Wall Type panel to open the Wall Type
drop-down list.

. In the Wall Type drop-down list, select the Basic
Wall: Exterior — Brick on CMU.

. In the Modify | Place Wall tab, in the Draw panel,
select the Line button.

. In the Options Bar, set the Height to Unconnected,;
then set the height to 10’-0".

NOTE

When you set the Height
to Unconnected, the
top of your wall will no
longer be constrained to
the level above.
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P — Figure 3-2

570 M / Set the Detail to Medium
B Floor Plans
Level 1
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Site by

B Ceiling Plans Sheets (all)
Lot & 21 Families

Level 2
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@-[@] Groups
@0 Revit Links
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to select, TAB for alternates, CTRL adds, SHIFT unselects.

[@ Groug [CJcoarse

9. Set the Location Line to Finish Face: Exterior, and check the Chain check box
(see Figure 3-3).

10. Click a spot in the Drawing Editor, release the mouse button, move the mouse
horizontally, enter 28 (28'-0"), and then press the <Enter> key to place the wall.
Press the <Esc> key or select the Modify button in the upper left of the interface
to finish the command.

11. Notice that the wall is being drawn in relation to the face of the wall; this is the
Location Line.

12. Again, select the Wall > Architectural Wall button from the Architecture tab.

13. In the Options Bar, change the Location Line to Core Face: Exterior, and place
another 28'-0" long wall.

Properties of ~ Wall Type Figure 3-3
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Set the Location Line to
Finish Face: Exterior
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Loc Line at 14.
Exterior Face ;

A A N

Wi 15.

16.

Notice that the wall is now being drawn in relation to the face of the
CMU core. Repeat with all the different Location Lines (see Figure 3-4).

Select the walls you placed and press the <Delete> key.
Select the Wall > Architectural Wall button from the Architecture tab.

Your previous wall properties will still be there.

Loc Line at 17.
Core Face

18.
Figure 3-4 19
Different Location Lines

20.

21.

Figure 3-5

The vertical wall moves
to the right 10’-0’, and the
horizontal walls follow

In the Options Bar, check the Radius check box, set it to 2'-0" (2), and
then pick the Rectangle button.

Click a spot, and draw a 15’-0" (15) rectangle by moving downward to the
right, watching the Listening Dimensions, and clicking a second time.
Select the right vertical wall, click the Listening Dimension and change
it to 25 (25'-0"), and press the <Enter> key.

This time, the vertical wall moves to the right 10'-0”, and the horizontal
walls follow.

Repeat these processes, selecting the other line types in the Draw panel
(see Figure 3-5).

22. Select the wall that you created, right mouse button
(RMB) click, and select Create Similar from the
contextual menu that appears.

NOTE:

In Revit, to enter Dimensions, start in feet. To get 24'-9”, you can enter 24 space
9. You can also enter 24.75. For smaller dimensions, 0 space 9 equals 0'-9”. You
can also enter 9” to get 0’- 9”, and 24’ to get 24'-0" (Figures 3-7 and 3-8).

' A quick way to create any new object is to call for a similar object.

NOTE:

If you wish, you can now
select another Wall type

23. Before placing the wall, be sure to check the Chain  from the Wall Type panel.
and uncheck the Radius check boxes on the Options
Bar. (You could now pick any type of line from the
Draw panel.)

24. Click in the Drawing Editor and, moving clockwise, click and place the new
walls as shown in Figure 3-6.

25. Select the vertical wall shown in Figure 3-7 to expose its temporary dimensions in
relation to the left wall.

26. Select the dimension, change it to 24 9 (24'-9"), and press the <Enter> key.

27. Repeat the previous process, changing dimensions on the other walls (Figure 3-8).




37" 6"

20

Change to

249 (20'-9")

28. Select the Default 3D View button on the Quick Access toolbar to bring the 3D
view of your walls into the Drawing Editor (Figures 3-9 and 3-10).

29. Select the Navigation Wheel button to bring up the Navigation Wheel.
30. On the Navigation Wheel, select Center and place a Pivot Point.

= HG-K-2 -

Architecture

b G

Modify| | Wall Door W| pPress F1 for more help

SEllEctv|

Figure 3-9
Select the Default 3D View button
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Figure 3-6

Moving clockwise, click and
place the new walls

Figure 3-7

Change the vertical wall to 24
9 (24'-9")

Figure 3-8

Change the horizontal walls
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Figure 3-10
Default 3D View

31. On the Navigation Wheel, select Orbit, and rotate the model view (see Figures
3-11 and 3-12).

32. Select Front on the ViewCube; the Front view appears.

As always, keep exploring; click on all the controls that you have been shown
(Figure 3-13).

33. Save your file as PLACING WALLS.

Figure 3-11

Select Center, and place a Pivot Point
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Figure 3-12

Select Orbit and rotate the
model view

=} - Elevations (Building EBlevation)
East
North
Sauth
West
5 Legends
[ Schedules/Quantities
Bl sheets (all)
-E¥] Families
w-[@ Groups
@6 Revit Links
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Figure 3-13
Select Front on the ViewCube

2 d{e S i s CREATING WALLS USING PICK LINES ON AN IMPORTED 2D CAD FILE

Using the Pick Lines option for creating walls allows you
to pick any 2D CAD or line drawing. This is especially
useful when you import a DWG, DXF, or MicroStation
DGN file.

1. Download the Carriage house Walls CAD file from
www.pearsondesigncentral.com, and place it in a new

BED ROOM

directory named WALLS. A _”,,\
2. Start a new drawing using the Architectural template. .l F CLOSET
3. In the Project Browser, double-click Floor Plans > © LVING _i' -

Level 1. LDINING O | Shower
4. Select Link CAD from the Insert tab to bring up the H;ATH \

Link CAD Formats dialog box. @ RN0M ’i'j
5.In the Link CAD Formats dialog box, select the ) T

CARRIAGE HOUSE WALLS file from the WALLS - =HAS

directory. . FTCHEN ;Q ©
6. The 2D CAD drawing will now appear in the Drawing \\\\ é‘ 9 -

Editor (see Figure 3-14). e o

Figure 3-14

2D CAD drawing appears in the Drawing Editor
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7. Select Visibility/Graphics from the View tab, or type
VG to bring up the Visibility/Graphics Overrides dia-

e e il ol log box (see Figure 3-15).
Visibility/ Graphics (VG) == | ®| - .
Controls the vabdty and gragh diey of ol semens, bl 8. In the Visibility/Graphics Overrides dialog box, select
S the Imported Categories tab.
Press F1 for more help
9. Inthe Imported Categories tab, check the Halftone check
Figure 3-15 box for the CARRIAGE HOUSE WALLS drawing.

10. Inthe Imported Categories tab, expand the CARRIAGE

Type VG to bring up the Visibility/Graphics Overrides .
HOUSE WALLS drawing, uncheck all the layers except

dialog box
A-Wall and B-Wall, and press the OK button to close the
dialog box.
11. This will turn off all the walls except the A-Walls and B-Walls in the AutoCAD
drawing (see Figures 3-16, 3-17, and 3-18).
12. Select the Architecture tab, and select the Wall button to bring up the Modify |
Place Wall tab.
13. In the Properties dialog box, in the Type panel, select the Basic Wall - Brick on
Mtl. Stud wall.
14. In the Modify | Place Wall tab, select the Pick Lines button and Finish Face:
Interior from the Options Bar drop-down list. Set the Wall Height to 10'-0" (see
Figure 3-19).
Visibility | Graphic Dverrides for Floor Plan: Level 1
Mordel Categanes | Annotaton Categares | Analytcal Model Categones  Imuorted Categories | iters |
¥ Show imported categories in this view A E] i |E
Figure 3-16 #‘
Check the Halftone check box | 7
J .
?
Figure 3-18
Fi -1
Figure 3-17 A-Walls and B-Walls
Uncheck all the layers except A-Wall and
B-Wall
Figure 3-19 ;@ A =~ :'E i b2 ul:l Revit 15 Book b | Thpe 2 keyword or p

ety TPece vl ]

Select the Pick Lines button

\: & Dm Dll' o

# " =TT
‘.”-—;z?a gt Eﬁ _ = [ 6% N
ga | PBOThaax 7 =
atry ‘ Modify ‘ View Measure Create I

iy U"\ | Location Line: Finish Face: Intej’[/ oﬁset:l 00"
Wall Centerline
\ Core Centerline
Finish Face: Exteriar
Finish Face: Interior {

Core Face: Bxterior
Core Face: Interior
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15. Move the cursor over each line in the Linked. DWG file as
shown in Figure 3-20. [ A "

16. Be sure that the blue dashed line that appears is inside the
AutoCAD line, not outside, and then click on each line (see
Figure 3-20).

17. Select the Trim button from the Modify panel (see Figure II%

)

3-21).

18. Select the endpoints of adjacent walls to Trim, and join all
the corners. |

19. Select the Default 3D View button from the View tab, and
place the model into 3D (see Figures 3-22 and 3-23).
20. Repeat Steps 12 through 19 selecting the Basic Wall:
Interior 4-7/8" partition (1-hr) wall, to create the interior
walls.
21. You will need the Trim/Extend tool to help you clean up |||i ¢
the walls.
22. In the Modify | Place Wall tab, in the Modify panel, select
the Trim/Extend button. Figure 3-20

Be sure that the blue dashed line is inside the
AutoCAD line

EHG- Q-2 =2 A O A -5 L[N 5 Revit15Book

EI’Iil L Dl DI = =

W | 36 cope - 2,

'_ = Aot - = § 88 6l = ) o & -
“ B - za |9 %S OB x f & Iﬁ I
ool b Trim [Extend to Comer (TR) i

Modify | Place Wall Trims o extends dements (such as walls or bears) to form 8 comer, pes Finis) ke:EﬂJ |J_E1uln uﬁ;s:lﬂ o ™ Radius: r

Press F1 for more help | [ Video is loading...

et o - =
i

Wew Walls ] [F Edit Type

Figure 3-21
Select the Trim button

Figure 3-22 Figure 3-23
Select the Default 3D View button The walls in 3D view
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23. Use the Extend button by first selecting the wall to extend to, then selecting the

wall to extend (see Figures 3-24 and 3-25).

24. Again, select the Default 3D View button from the View tab, and place the model

into 3D (see Figure 3-26).

25. You have now traced your 2D CAD drawing and converted it into a 3D Revit model.
26. Save this file as REVIT WALLS by PICK LINES.

Figure 3-24 o

The Trim/Extend tool
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View Measure Create Ciraw

| TrimfExtend Single Element —
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ition (1- =

Figure 3-25

Extend the partition walls

boundary defined by another element.

Press F1 for more help | EE* Video is loading... * l
—
—

Figure 3-26
Default 3D View

{35 8 CREATING AND MODIFYING WALLS

Basic Wall objects are included with Revit. You can easily create your own special-
ized walls.

1. In the Application menu, select New > Project to create a new Architectural project.
2. Save the new project as CREATING WALL TYPES.
3. Select Floor Plans > Level 1 in the Project Browser.

4. Select Architecture tab > Wall button to bring up the Wall Type Selector in the
Properties dialog box.




5. In the Properties dialog box, select the Edit Type button to bring up the Type

Properties dialog box.

6. In the Type Properties dialog box, select the Duplicate button and change the
name to TEST WALL (see Figure 3-27).
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x Figure 3-27
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7. In the Type Properties dialog box, select the Edit button to bring up the Edit
Assembly dialog box
8. In the Edit Assembly dialog box, select the Preview button; then set the Sample
Height to 4'-0", and finally select Section: Modify Type from the View drop-
down list. Click in the viewer, and zoom in and fill the view (see Figure 3-28).
9. In the Edit Assembly dialog box, focus on the Layers section.
10. Core Boundaries surround the main support Structure of the wall.
11. One adds additional layers of materials to the exterior and interior of the main
Core Boundary.
12. New layers can be added by pressing the Insert button, and using the Up and
Down buttons to adjust the layer location in the wall.
13. Press the number 1 button, and then press the Insert button to add a new layer on
the Exterior Side (see Figure 3-29).
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The Edit Assembly dialog box

The Insert button
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14. Add three layers on the Exterior Side of the Core Boundary and two layers on

the Interior Side.

15. Select the number 3 button, and select Membrane Layer from its Function drop-

down list (see Figure 3-30).
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16. Repeat, changing the Function of each layer to match Figure 3-31.
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1 [Finish 1[4] <By Category> 0 0 17. Select the Material selector for Layer 5 to bring up the Material
Z‘I‘I‘lermal,wr Lay <ByCategory> 0 0" Browser.
3 [Membrane Lay <By Category> 0' 0" . .
e aiars mh:gm o' 0" 18. In the Material Browser, enter CMU in the search field, and select
5 [Structure [1] <By Category> 0 8" Concrete Masonry Units from the available selections.
6 |Core Boundary Layers Below W 0' 0" . . .
7 [substrate [2] | <By Category> 0 O° 19. Press the OK button in the Material Browser to return to the Edit
<By Category> 0’ 0" Assembly dialog box (see Figure 3-32).
i . 20. Repeat and set the Material and Thickness for the other layers as
Tigure 557 shown in Figure 3-33.
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Figure 3-33 Thermal Mass 21.8808 BTU/°F
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NOTE:

Membrane Layer signifies liquid waterproofing, paint, etc. Thermal/Air Layer is any air
cavity. Substrate is any nonstructural member such as wall channels. Finishes are any
final surface such as gypsum board, metal, brick, etc. The difference between Finish 1
[4] and Finish 2 [5] is the line thickness in the drawing.

21. Press the OK button in the Edit Assembly dialog box to return to the Drawing
Editor.

22. Change to the Default 3D View.

You have now created a CMU wall with an airspace and brick veneer on the exterior,
and metal channels and gypsum board on the interior.

23. Select the wall you created to open the Modify | Walls tab.

24. Tn the Modify | Walls tab, select the Copy button, and move a copy of the wall to
the right.

25. Select the second wall, and select the Create Parts button in the Create panel to
show all the parts of the wall (see Figures 3-34 and 3-35).
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Figure 3-34
Select the Create Parts button

Figure 3-35

Wall shown with its parts

You now have this type of wall available for placement whenever you need it.

NOTE:

Do not use Create Parts until you have read this Create Parts exercise. Once you use
Create Parts, you cannot add windows or doors.

Chapter 3 Walls
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